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Welcome to your 
new Audient iD48 
Audio Interface

Inside the box:

•	 iD48
•	 USB-C to USB-C cable
•	 Quick Start Guide
•	 Rack Ears
•	 Mains Power Cable

To help get you started please visit  
audient.com/products/iD48
to download the latest software 
and firmware.

Features include:

•	 8 x Class-A Audient Console Mic 
Preamps

•	 Class Leading AD/DA Converters
•	 2 x Discrete JFET Instrument Inputs
•	 Main and Alt Speaker Outputs
•	 2 x Independent Dual Headphone 

Outputs
•	 2 x ADAT Inputs & Outputs
•	 8 Switchable Balanced Inserts/Line 

Outputs
•	 Ultra-low Latency DSP Mixer
•	 Audio Loop-back
•	 2 x User Defined Function Keys
•	 Dedicated Dim and Cut Controls
•	 +48V, Pad, and HPF Controls
•	 USB 3.0 Compliant
•	 24bit/96kHz
•	 Word Clock Input & Output
•	 All-Metal Design
•	 Free Software + Plugins

https://audient.com/products/audio-interfaces/id48/overview/
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iD48 Overview
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Important Safety Instructions

Please read all of these instructions and save them for later reference before connecting
the power cable and powering up iD48.

The iD48 uses an internal switch mode power supply that will operate on AC voltages between 
90V and 264V, 50-60Hz so can be used worldwide without requiring the operating voltage to be 
manually adjusted.

Consult a qualified technician if you suspect difficulties. Do not attempt to tamper with the
power supply or mains voltages - HAZARDOUS TO HEALTH. To reduce risk of fire or electrical 
shock, DO NOT expose this apparatus to rain or moisture.

WARNING! No user serviceable parts inside. Please refer servicing to qualified service personnel. 
You can find more information on how repairs at audient.com/support

Safety Information

http://audient.com/support
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Important Safety Instructions

1.	 Read these instructions
2.	 Keep these instructions
3.	 Heed all warnings
4.	 Follow all instructions
5.	 Do not use this equipment near water
6.	 Clean only with dry cloth
7.	 Do not install near any heat sources such as radiators, heat registers, stoves, or other equipment 

(including amplifiers) that produce heat
8.	 Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug 

has two blades with one wider than the other. A grounding type plug has two blades and 
a third grounding prong. The wide blade or the third prong are provided for your safety. If 
the provided plug does not fit into your outlet, consult an electrician for replacement of the 
obsolete outlet

9.	 Protect power cords from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the equipment

10.	Only use attachments/accessories specified by the manufacturer
11.	 Unplug this equipment during lightning storms or when unused for long periods of time
12.	 Refer all servicing to qualified service personnel. Servicing is required when the equipment has 

been damaged in any way, such as power supply cord or plug is damaged, liquid has been 
spilled or objects have fallen into the equipment, the equipment has been exposed to rain or 
moisture, does not operate normally, or has been dropped

13.	 For products that are a mains powered device: The equipment shall not be exposed to dripping 
or splashing and no objects filled with liquids (such as vases) shall be placed on the equipment

Safety Information
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Declaration of Conformities

FCC Part 15B

This apparatus has been tested and found to comply with the limits of a class-A digital device, pursuant to Part 15B of 

the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 

installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in 

accordance with the instructions, may cause harmful interference to radio communications. If this equipment does 

cause harmful interference to radio or television reception, which can be determined by turning the equipment off 

and on, the user is encouraged to try to correct the interference by one or more of the following

measures:

	 1.	 Re-orient or relocate the receiving antenna

	 2. 	 Increase the separation between the equipment and receiver

	 3. 	 Connect the equipment into an outlet on a different circuit from that 

		  to which the receiver is connected

	 4.	 Consult the dealer or an experienced radio/TV technician for help

		  We, Audient Ltd, Aspect House, Herriard, Hampshire, RG25 2PN, UK, 
		  01256 381944, declare under our sole responsibility that the product iD48 
		  complies with Part 15 of FCC Rules. 

		  Operation is subject to the following two conditions:

		  1. 	 This device may not cause harmful interference,
		  2. 	 This device must accept any interference received,

			   including interference that may cause undesired operation

Audient Ltd has conformed where applicable, to the European Union’s Directive 
EN 63000:2018 on Restrictions of Hazardous Substances (RoHS) as well as the following 
sections of California law which refer to RoHS, namely sections 25214.10, 25214.10.2, and 58012, 
Health and Safety Code; Section 42475.2, Public Resources

We, Audient Ltd, declare that the product, the iD48, to which this declaration  
relates, is in material conformity with the appropriate CE standards and  
directives for an audio product designed for consumer use.

We, Audient Ltd, declare that the product, the iD48, to which this declaration  
relates, is in material conformity with the appropriate UKCA standards and  
directives for an audio product designed for consumer use.



Installation
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macOS
1. Download the iD Software Mixer Application 
for Mac from audient.com/iD48/downloads

2. Open the downloaded file and drag the iD 
icon into the Applications folder.

3. Connect the iD48 to the Mac using the 
included USB-C cable. If necessary, a third-
party USB-C to A cable can also be used. The 
device requires a connection to a USB 2.0 port 
or greater.

4. Run the iD Software Mixer Application 
from your Applications folder. To ensure your 
interface has the latest features, you may be 
asked to install a firmware update, follow the 
on-screen steps to do this.

5. Upon opening the iD Software Mixer 
Application for the first time, a Product 
Registration screen will appear, allowing you 
to register your product with Audient ARC to 
receive update notifications and access to 
exclusive plugins and software. You can also 
do this later if necessary.

macOS Minimum System Requirements: 
macOS: 10.13.6 (High Sierra) or Later 
Intel CPU or Apple Silicon
1GB RAM Minimum

USB - C

http://audient.com/iD48/downloads


Windows
1. Download the iD Software Mixer Application 
for Windows from audient.com/iD48/
downloads

2. Open the installer and follow the instructions 
shown on the screen. After installing the drivers, 
plug the iD48 into the PC. It can sometimes 
take a few moments for Windows to finalise 
the drivers before the unit is recognised. 

3. Run the iD Software Mixer Application from 
your Start menu. To ensure your interface has 
the latest features, you may be asked to install 
a firmware update, follow the on-screen steps 
to do this.

4. Upon opening the iD Software Mixer 
Application for the first time, a Product 
Registration screen will appear, allowing you 
to register your product with Audient ARC to 
receive update notifications and access to 
exclusive plugins and software. You can also 
do this later if necessary.

Windows Minimum System Requirements: 
Windows 10 or Later 
Intel Core 2 @ 1.6Ghz, 
AMD equivalent, or ARM Processor
1GB RAM

10

http://audient.com/iD48/downloads
http://audient.com/iD48/downloads


iD App & Firmware Update
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Launch the iD Software Mixer 
Application

Launch the iD48 Software Mixer application 
by finding it in the following folder:

Macintosh HD > Applications > iD 
Start > All Programs > Audient > iD

On macOS, the iD Software Mixer Application 
will launch into the Menu bar, in the top right 
corner of the screen. Click on the small iD icon 
to access the features of the application. 

On Windows, the iD Software Mixer 
Application will launch into the system tray, 
typically in the bottom right corner of the 
screen. Right-click on the iD icon to access the 
features of the application. 

For more information on the iD Software 
Mixer Application feature set, please refer to 
page 30 onwards of this manual.

You can manually check for updates by going 
to the Help menu and selecting ‘Check
for Updates’. It will notify you if you’re on the 
latest version of firmware or if you need to 
update. 

Registration With Audient ARC

When you first open the iD Software Mixer 
Application, a window will open asking you 
to register your unit to Audient ARC. Simply 
follow the instructions on-screen to create an 
account and register your unit. 

This will give you access to free innovative 
software and services; meaning you’ll have 
everything you need to get recording straight 
away. 

Please note that second-hand purchases are 
not eligible for registration on Audient ARC, 
please read our ARC Terms and Conditions 
for more information: https://audient.com/
arc-terms-and-conditions/

If you plan on registering the product at a later 
date, you can simply close the registration 
window. You’ll see the window again the next 
time you use the unit. 

Check for Firmware Updates

If your computer is connected to the internet, 
the iD Software Mixer Application will check 
for firmware updates whenever a unit is 
connected. If there is a firmware update 
available then the iD Software Mixer 
Application will notify you again the next time 
you use the unit.

https://audient.com/arc-terms-and-conditions/
https://audient.com/arc-terms-and-conditions/


Hardware Features



Instrument Input

iD48 employs a discrete Class-A JFET 
instrument (D.I) input on channels one and 
two which is easily accessible on the front of 
the unit.

The JFET circuitry adds a tiny bit of colour 
and harmonics to the signal, making it sound 
great on guitars and basses.

Plugging in a TS (tip-sleeve unbalanced) jack 
will override the mic signal and turn either 
channel 1 or channel 2 into a fully-fledged, 
fantastic-sounding instrument input.
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Microphone Preamplifiers
& Line Inputs

iD48 features 8 Audient Console microphone 
preamplifiers. These preamps
are based on the circuits found on Audient’s 
classic consoles and are the same that are 
used across our entire ‘iD Interface Range’.

The design features discrete Class-A circuitry 
providing exceedingly low distortion and
noise performance. From a sonic point of 
view, iD48 is fast, open and detailed.

Amphenol TM XLR/TRS Jack combi-
connectors provide microphone and line 
inputs. The line inputs are padded by -10dB 
before passing through the microphone 
preamplifiers to minimise clipping on line-
level signals 

The microphone preamplifiers feature:

•	 58 dB of clean gain
•	 >2.8kΩ input impedance which provides 

a punchy tone from any microphone 
transducer type



Input Controls

Below each channel’s Gain Control, there 
is an indicator panel showing which of the 
channel’s Input Controls are active. Each 
channel has the following input controls:

Phantom Power Switch - There is an 
independent phantom power switch for each 
microphone channel. When the switch is in 
the UP position, this provides full phantom 
power (48V ±4V, 10mA per channel) to the 
microphone connected to this channel. 

Please note that the iD48 will only send 
phantom power to XLR connections, the TRS 
line inputs will not receive phantom power.

High Pass Filter - Each preamp also includes 
a switchable hardware high pass filter that 
has a cut-off frequency of 100Hz. This is good 
for removing rumble and room noise from 
your recordings. The high pass filter can be 
switched on and off from the included iD 
Software Mixer Application.

-10dB Pad - Each input features a switchable, 
hardware -10dB pad to help lower the signal 
level when recording particularly hot sources 
such as drums. The Pad can be switched on 
and off from the included iD Software Mixer 
Application.

ADC (Balanced Send & Returns) - Each 
channel has a switchable insert point before 
the ADC (Analog to Digital Converter) using 
the DB25 Inputs and Outputs on the rear of 
the interface. 

There are three modes that the channel can 
be set to. 

•	 Mic
•	 ADC Direct
•	 Mic Insert

The ADC light will illuminate when the unit is 
set to ‘Mic Insert’ or ‘ADC Direct’ mode to 
indicate that this input channel is taking the 
signal from the ADC Inputs on the rear of the 
unit instead of the Mic/Line Combi Connectors

These settings are referred to as the ADC Path 
Settings and are adjusted per channel in the 
included iD Software Mixer Application.

14
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How to Utilise the Three ADC Path Settings 

Mic

When using the ‘Mic’ ADC Path setting, the ADC is fed directly from the output of the built in 
Audient Console Mic Preamps. The Line Output/Insert Send DB25 port can then be used as 
additional line outputs. 

The additional line outputs can then be used to feed external hardware such as headphone 
amps. 



16

ADC Direct

When using the ‘ADC Direct’ Setting, the ADC for this channel is fed from the Insert Return/
ADC Input DB25 port, providing you a way to input audio whilst bypassing the iD48’s built in 
Audient Console Mic Preamps for the cleanest signal path to the ADCs possible.

One use case of this would be if you wish to use an external analog preamp or wish to feed in 
a line level signal without passing it through iD48’s preamps.

It is important to note that when in this mode, the signal from the Mic/Line input is not accessible.

This setting can also be used if you wish to utilise hardware effects whilst Mixing in your DAW 
software. 

The Line Output/Insert Send DB25 Port in this mode is fed from the DAC, rather than from the 
built in Audient Console Mic Preamp, and provides additional line outputs just like on the ‘Mic’ 
ADC Path setting.
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You can therefore feed audio from your DAW to the Line Output/Insert Send DB25 Port, pass 
this through hardware effects and then return the processed audio to the Insert Return/ADC 
Input DB25 port to be re-recorded into your DAW software. 

Most DAWs will have a ‘Hardware Insert’ mode or plug-in that allows you to easily route the 
audio in your DAW, please see your DAW software’s documentation or manual for information 
on how to use these features. 

You will also need to set your Line Output routing in the software routing matrix to either “DAW 
ANALOGUE” or “DAW DIGITAL”, depending on which channels you wish to route the signal 
from. This is done in the System panel of the iD Mixer Software which is covered in more detail 
in the Software section of this Manual.
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Mic Insert

When using the ‘Mic Insert’ ADC Path Setting, the Line Outputs/Insert Sends and Insert 
Returns/ADC Input DB25 ports act as a Insert point. 

This allows you to add hardware effects, such as a hardware compressor or EQ, between the 
output of the iD48’s Preamp and the ADC input. This is perfect for building vocal chains or 
otherwise adding effects while tracking.
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Monitor Control

The iD48 provides excellent monitor control 
functionality using the large aluminium
Volume control.

Hardware Metering

The 8-segment hardware meters indicate the 
playback level of your Main Monitoring Mix in 
the iD Software Mixer Application. 

Power Control

To power the iD48 Down, press and hold the 
Monitor Control for 3 seconds. A short LED 
animation will play and the unit will then be 
powered off. 

To Power the unit on again, press the Monitor 
Control down once. A short LED animation 
will play and the unit will power up. 

If the Unit is powered up but idle, i.e no audio 
is passing through the unit. The Meter LEDs 
will periodically show a short animation to 
indicate that the unit is still powered up.

F-Keys

The two F buttons, F1 and F2 are the function 
keys and allow you to activate a number of 
monitoring functions from the iD Software 
Mixer Application. More information on how 
to set this up can be found in the Software 
section of this Manual.

The ALT Button

The ALT Button lets you quickly switch between 
your Main Monitors and a second set of 
alternative speakers. This is useful to check 
how your mix translates on various speaker 
sets. 
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Headphone Outputs

iD48 features two independent high-current 
headphone amplifiers. This can be accessed
using both the 6.35mm sockets found on the 
front of the unit. 

The headphone outputs can comfortably 
drive a wide range of headphone impedances 
meaning that you will get great-sounding 
audio no matter what model of headphones
you have.

Each headphone Output has a dedicated 
volume control so you can accurately set the 
listening level.

Monitor Outputs

iD48 has two pairs of dedicated stereo 
speaker outputs on the rear panel in the 
form of balanced TRS jack connectors. The 
outputs are impedance-balanced using the 
same topology as our flagship console, the 
ASP8024-HE.

The outputs are fed from high performance 
DACs (Digital to Analogue Convertors) 
sending clean audio to your speakers, perfect 
for critical listening.



21

ADC Inputs/Insert Returns

This DB25 connector provides 8 balanced 
inputs in Tascam Format. These directly feed 
iD48’s Analog to Digital Converters (ADCs) 
and can either be used as direct inputs to the 
ADCs or as insert returns depending on the 
ADC path settings selected for a particular 
channel. More information about the ADC 
Path Settings can be found on page 15.

Line Outputs/Insert Sends

This DB25 Connector provides 8 balanced 
outputs in Tascam Format. These are either 
fed from the Outputs of iD48’s built in Audient 
Console Mic Preamps in order to be used as 
Insert Sends, or they can be used to send 8 
line-level outputs. This is set by adjusting the 
ADC path setting for a particular channel. 

Both the ADC Inputs/Insert Returns and 
Line Outputs/Insert Sends connections 
use a Tascam Format Pin Out. To ensure 
you use the correct looms for your iD48, 
please see the Tascam Format pinout 
diagram below.
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Digital Inputs and Outputs

iD48 features two optical inputs and two 
optical outputs. These can be set to operate
Using  S/PDIF or ADAT using the iD Software 
Mixer Application. 

In S/PDIF mode, each optical connection can 
carry two channels of audio up to 96kHz.

Running in ADAT mode, each optical 
connection can carry 8 channels of audio at 
44.1kHz and 48kHz and up to 4 channels of 
audio at 88.2kHz and 96kHz (due to how the 
ADAT SMUX protocol operates).

These digital connections are perfect for 
adding additional inputs and outputs to the 
iD48, such as adding additional Mic Preamps 
or providing additional monitoring outputs. 
This is very useful for larger recording sessions.

More information on how the iD Software 
Mixer Application is used to route to the 
optical outputs can be found under The 
Routing Matrix section of this manual.

Word Clock Input and Output 

iD48 provides both a BNC word clock input 
and a BNC word clock output to allow the 
interface to be synced to external clocks and 
digital devices. The Word Clock input has a 
switchable 75 Ohm termination which can be 
adjusted in the iD Software Mixer Application. 
This should be enabled if the iD48 is the last 
or only device in a BNC word clock chain. This 
stops any clock reflections and provides more 
stable clocking. 

Clocking Information

When connecting external digital devices to 
iD48, it is important to get the clocking setup 
correct to ensure all the devices are synced. 
If this is not set correctly, you may experience 
clicks, pops or distortion in your audio. 

It is important to note that in a digital setup, 
there should only ever be one device acting 
as the master clock. All other devices will then 
sync to this, either via the Optical ports or the 
BNC Word Clock connections.
 
With a wealth of digital I/O, there are many 
ways that the iD48 can be set up to clock with 
other digital equipment.
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iD48 Syncing to an External Device via ADAT or  S/PDIF  

In this setup, the external device would be acting as the master clock. The external device’s 
Optical Output is connected to iD48’s Optical 1 Input. 

The iD48’s Clock Source is set to ‘Digital 1’ or ‘Digital 2’, depending on which optical port you 
are using. This allows the iD48 to sync to the incoming ADAT stream from the external device.
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iD48 Master clock via ADAT or S/PDIF

In this setup, the iD48 would be acting as the master clock and sending the clock to an external 
device via the Optical ports. 

The External Device’s Optical output is connected to iD48’s Optical Input 1 and iD48’s Optical 
Output 1 is connected to the external device’s Optical Input. 

The iD48’s Clock source is set to Internal as it is acting as the master clock. The external device 
is set up to sync to the incoming clock via its Optical port.
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iD48 Master Clock via BNC

In this setup, the iD48 would act as the master clock and send the clock to two external devices via 
its BNC Word Clock Output. The first external device’s Optical Output is connected to iD48’s Optical 
Input 1 and iD48’s Optical Output 1 is connected to the external device’s optical input.

Similarly, the second external device’s Optical Output is connected to iD48’s Optical Input 2 and 
iD48’s Optical Output 2 is connected to the external device’s optical input.

Now, a BNC T-Connector is plugged into the BNC word clock input of the first device. This is used to 
daisy chain the BNC word clock signal from the first external device to the second. A 75-ohm BNC 
Word Clock cable is then connected from iD48’s BNC Word Clock output to the Input of the BNC 
T-Conenctor. A second 75-ohm BNC Word Clock cable is then connected from the output of the 
BNC T-Connector to the BNC Word Clock input of the second External Device.

The iD48’s Clock source is set to Internal as it is acting as the master clock. The external devices 
should both be set up to sync to the incoming clock via their BNC Word Clock inputs. To ensure 
correct operation, 75-Ohm Termination should be enabled on only the second external device. 



26

iD48 Syncing via Master Clock 

In this setup, an external clock source is being used to provide a clock to the iD48 via its BNC Word 
Clock input. 

A  75-Ohm BNC Word Clock Cable is connected to the BNC output of the external Clock and is 
plugged into iD48’s Word Clock input.

iD48’s Clock Source should now be set to Word Clock. In addition, the 75 Ohm termination should 
be enabled if the iD48 is the last, or only device in the Word Clock chain. 

The above setups cover the most common configurations but are not 
exhaustive. For more information regarding clocking, please visit out 
Support Help Desk or contact us at support@audient.com

mailto:support%40audient.com?subject=iD48%20Clocking%20Support


iD48 Rack Ear Fitting Instructions

27

If you wish to add iD48 to a Rack, then this can be achieved by fitting the Rack Ears included 
in the box. With the Rack Ears fitted, the iD48 is a standard 1RU unit. 

First, you would need to remove the rubber feet from the underside of the unit. To do this 
remove the Phillips head screws from the centre of each foot with a screwdriver, and lift the 
foot off the chassis.

Now, the Rack Ears can be attached to the side of the unit. On each side of the unit, there 
are four threaded holes. Align the Rack Ears with these holes, and using a screwdriver, 
screw the 4 included M3 Pozi screws into the threaded holes to secure the Rack Ear as 
shown below.
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Repeat this process for the other Rack Ear. With the Rack Ears fitted, the iD48 can now be 
added to your Rack. 

Rack Safety Instructions

iD48 requires 1U of vertical rack space and a minimum of 400mm rack depth, allowing
for cables. It weighs 3.9kg and for fixed installations - such as a studio - the four front
panel mounting screws will provide adequate support. The front panel depth is 3mm
at the mounting positions.

iD48 does not generate significant heat and is cooled by natural convection. We
recommend that the unit should not be used in locations where the ambient temperature
is greater than 35°C. Ventilation is via slots on either side of the enclosure, and these
must be clear of obstruction.

Do not mount iD48 immediately above or below any other equipment which generates
significant heat, for example, a power amplifier.
 



Software Features
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iD Software Mixer Application
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Input Channels - Channel Types

The iD Software Mixer Application features 
three types of input channels:

Mic Inputs 
These are the inputs where you will see the 
signal from the iD48’s eight analogue inputs.
 
Digital Inputs 
These are the inputs from the iD48’s optical 
inputs. The number of digital inputs present 
on the iD Software Mixer Application 
depends on the digital input type (S/PDIF or 
ADAT) and the sample rate being used. 

DAW Returns  
These are the signals being played back 
from your DAW. The iD48 has 10 DAW Return 
Channels, allowing you to set up multiple cue 
mixes or sends to hardware outboard gear.

Using these three channel types you can 
build up your main monitor mix and up to 
four additional cue mixes.

It’s important to note that the iD 
Software Mixer Application only 
controls the monitoring of the iD48. 
Changes made to the iD Software 
Mixer won’t affect the level present in 
your DAW or audio software.
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Channel Name

Phase Flip
+10dB Boost

Pan Control

Mono Grouping

Solo

Pad
High Pass Filter

ADC Path

Fader
Meters

Mute
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Channel Features

Channel Name
By double-clicking on the name of the channel 
you can rename it to help you organise your 
iD Software Mixer. You could name a channel 
‘Kick’ or ‘Snare’ for example.

Input Controls
High Pass Filter - This activates the analogue 
high pass filter on the input of this channel.  
The cut-off frequency of the High Pass Filter 
is 100Hz so is great for removing rumble and 
room noise from your recordings.

Phase Flip - Inverts the polarity of the signal 
by 180° to stop phase cancellation. This is 
useful if you are micing the rear of a guitar 
amplifier or the underside of a snare drum.

Pad - The Pad control reduces the incoming 
signal level by -10dB using an analog pad 
circuit. This is helpful if recording a very high 
signal level and need to reduce the signal 
level to stop clipping from occurring. 

Boost - Selecting this will digitally boost the 
incoming signal by +10dB for recording quiet 
sources. This will also affect the audio being 
fed into your DAW.

ADC Path - This drop-down menu allows you 
to select between the following ADC Path 
Settings: Mic, ADC Direct, Mic Insert.

More information on how these ADC Path 
Settings can be used can be found in the 
Hardware section of this manual. 

Pan Control
Allows you to send the audio to the left, to 
the right or anywhere between on your Main 
Monitor Mix or Cue Mixes.

Stereo Grouping
Allows you to group two adjacent channels 
together into a stereo channel with a single
fader controlling the level of both channels. 
When a channel is stereo grouped, the pans 
will automatically be set to hard left and 
hard right.

Solo
The Solo button mutes all other channels 
other than the one that is currently soloed. 
Multiple channels can be soloed at one time.

Mute
The Mute button stops this channel from 
outputting audio whilst it is engaged.

Fader
The fader controls the amount of signal that 
is sent to the currently selected mix. This can 
be set to anywhere between -inf dB to +6dB.

Meter
The meter shows the current signal level in 
dBFS. Should the signal level exceed 0dBFS 
then the peak indicators will illuminate red to 
indicate a peak. The peak indicators can be 
turned off by clicking on them. You can also 
turn off all peak indicators using Alt + Click.
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Master Section Features

Mix Selection

Cue Mix 
Name

Cue Mix 
Level

Mix Solo

Mix Meters

Channel Views

Monitor Controls

Chronometer
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Channel Features

Mix Selection
Clicking on one of the mix tabs allows you 
to make changes to that mix. When a mix 
is selected, it expands to reveal additional 
controls for that mix.

Cue Mix Name
Double-clicking on a Cue Mixes name allows 
you to rename the Cue Mix. If, for example, 
you were creating mixes for two separate 
band members, you could name them 
‘Drummer’ and ‘Guitarist’.

Mix Solo
The Solo button allows you to audition each 
of the Cue Mixes through your monitors.

Mix Level
The Mix level allows you to control the overall 
level of the Cue Mix that is sent to the outputs.

Mix Meters
The Mix meters show the master signal level 
of the selected mix.

Chronometer
The Chronometer allows you to see not only 
the current signal level but also the signal
level from a few seconds previously.

This can be great to track down a sudden 
loud transient on a particular cue mix or to 
monitor the change in level over time as you 
make changes to a mix.

Channel Views
These three buttons allow you to control which 
of the three channel types are shown in the
mixer. If for example, you weren’t using the 
digital inputs for a particular project, you can
simply hide the optical channels by clicking 
‘OPT’.

Monitor Controls
These six buttons control various aspects of 
iD48’s monitor controller capability. The
function of each control can be found below:

•	 TB (Talkback) 
The Talkback button switches talkback 
on and off. More information regarding 
talkback and its various settings can be 
found in the ‘System Panel’ section of this 
manual. 

•	 ø (Phase Flip) 
Pressing this switch flips the phase of 
one side of the stereo field. Pressing this 
switch will also trigger the Mono button. 
This will remove centred elements from 
your monitoring in order to hear the 
panned elements of a mix. 

•	 Mono 
The Mono button sums the stereo outputs 
down to mono. This can be used to 
quickly check the mono compatibility of 
your mix to make sure it’ll sound great 
almost anywhere. 
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•	 ALT 
Alt allows you to quickly switch your 
monitor path to a secondary set of 
monitors to let you check how your mix 
translates on various speakers. 
 
You can select which outputs the ‘ALT’ 
monitor control flips to in the System 
Panel. 

•	 DIM 
Reduces the output level by a preset 
amount which can be great if you get a 
call or need to quickly chat to someone 
during a session. 

•	 Cut 
Cuts all signal currently being sent to the 
Main Mix of the iD48. 

Assigning F-Keys

Various functions of the iD Software Mixer 
Application can be assigned to the Function 
Keys of the iD48 to allow you to quickly control 
your monitoring at the click of a button.

To assign a monitor control to an F-Key, simply 
right click on the control and select the F-Key.
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System Panel Features

Digital Input and 
Output Format

Default Clock 
Source

Word Clock 
Termination

Mono
Mode

DIM and ALT 
Trim Settings

Output 
Routing 

Selection

Routing 
Matrix
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System Panel Features

Digital Input/Output Format

This option allows you to select whether the 
Optical Inputs and Outputs uses the ADAT or 
the S/PDIF digital format. When using S/PDIF 
each optical port can handle 2 channels of 
audio. When using ADAT, each optical port 
can handle 8 channels of audio at 44.1kHz or 
48kHz, or 4 channels of audio at 88.2kHz or 
96kHz. 

If required, one Input/Output can be set to 
ADAT and the other to S/PDIF at the same 
time.

Preferred Clock Source

The clock source can be selected from 
either the internal clock, one of the two 
optical inputs or the Word clock input. More 
information about choosing a clock source 
can be found in the clocking section of this 
manual.

When using an external clock source the 
indicator beside the selector shows the 
current status of the clock on that input.

•	 Red - No clock signal detected on input.
•	 Amber - A clock signal is detected but at a 

different sample rate to iD48.
•	 Green - A clock signal is detected and is at 

the correct sample rate. 

To ensure you are getting a reliable sync with 
an external clock source, the indicator should 
be green. 

If a red indicator is shown, please check 
the physical connection of the clock source 
and ensure that the correct digital format 
is selected. If an orange indicator is shown, 
adjust the sample rate of either the external 
device or iD48 so that the sample rates 
match.

Word Clock Termination

This control lets you enable or disable the 75-
Ohm Termination on iD48’s BNC Word Clock 
Input. More information about Word Clock 
termination, and when you may require this 
can be found in the clocking section of this 
manual.

Mono Mode

When iD48’s Mono feature is engaged this 
option controls whether the mono signal
is sent to the left, right or both monitors. 
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Dim Trim Level

When iD48’s dim function is engaged, 
this control defines how much the level is 
reduced by.
 
ALT Speaker Trim Level

This control defines the level drop/boost 
when iD48 is switched to ALT speaker
mode. This is used to balance levels between 
different speaker brands.

Output Routing Selection

Opens the Routing Matrix for either the 
Monitor Outputs, Line Outputs, Digital 
Outputs or the Talkback channel.

Routing Matrix

The Routing Matrix allows you to control the 
audio source for each of iD48’s outputs
from the following options:

•	 Main Mix - This takes the signal from the 
Master Mix of the iD Software Mixer. This 
is what is usually used for most standard 
playback. 

•	 ALT - This takes signal from the Master 
Mix but only when the Alt speaker mode 
is active. 

•	 Cue A, B, C & D  - This takes signal from 
the Cue Mixes which can be created 
using the iD Software Mixer. Please note 
that the hardware volume control does 
not affect these mixes and the Cue’s have 
separate trims which can be adjusted 
when the Cue Mix is selected in the Main 
Mixer Window. 

•	 DAW THRU - This allows you to route to 
outputs exactly as they would appear 
in your DAW. For example, if you set 
Analogue out 1+2 to DAW THRU, anything 
your DAW sends out to Outputs 1+2 will be 
sent directly to Analogue Outputs 1+2. 
 
Please note that in DAW THRU, the 
channel in question will bypass any 
volume control and audio will be passed 
at full scale. If this output is sent to a set 
of monitors without inline attenuation, this 
may be very loud. The only exception to 
this is the headphone outputs where the 
volume control will still function even in 
DAW THRU mode.
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Line Outputs Routing Matrix

Beyond the typical Main Mix, ALT speaker and CUE mix options, the Line Output’s Routing 
Matrix includes two additional options instead of DAW THRU to provide further flexibility; 
DAW Analogue and DAW ADAT.
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DAW Analogue

When set to DAW Analogue, Line Outputs 1 to 8 are fed from output channels 1-8 
respectively. 
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DAW ADAT

When set to DAW ADAT, Line Outputs 1-8 are fed from output channels 9-16 
respectively. 

Please note that it’s possible to assign each Line Output channel differently. For example, you 
could have Line Outputs 1+2 set to DAW Analogue and being fed from output channels 1+2, 
and at the same time, Line Outputs 3+4 are set to DAW Digital and are being fed from output 
channels 11+12. 

Along with each input channel also having an independent Mic Mode setting, this provides a 
huge amount of routing flexibility when incorporating external hardware equipment into your 
setup. 

For example, the flexible routing makes the iD48’s Line Outputs perfect for adding hardware 
effects, such as compressors, or reverbs as inserts in your DAW. The process of setting up 
hardware inserts will differ between DAWs and therefore, it is outside of the scope of this 
manual to explain this process. We’d recommend consulting the documentation for your DAW 
to find further information.
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Output Routing Signal Flow Diagram

The Diagram below shows how the iD48’s output channels in the DAW are routed to the 
Physical outputs via the Software Mixer and the Routing Matrix

The Routing Matrix allows you to choose which source is routed to a particular output, either 
one of the Mixes from the Software Mixer, or via a direct send using the DAW THRU, DAW 
Analogue and DAW Digital functions
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Talkback 
 
iD48’s Talkback function allows you to take the signal from a microphone and send it to 
the Cue Mixes. This means that you can communicate directly with performers and artists 
while tracking to give feedback and instruction. You can adjust Talkback settings from the 
Talkback tab of the System Panel. 

Talkback Source

Talkback Device
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Talkback 
 
The Talkback source allows the talkback 
input to be taken from one of iD48’s internal 
inputs or from an external device connected 
to the host computer (such as a built-in 
microphone or USB microphone).

When you select an internal input as your 
Talkback channel,  the corresponding 
channel in the iD Software Mixer will be 
changed to a Talkback channel which will 
have a TB button in the centre. 

If External Device is selected then you’ll 
see a drop-down menu to choose which 
external device you wish to use. When using 
an external device, the talkback signal will 
appear on channel DAW 10.

Talkback can be turned on or off by pressing 
the TB button on that channel, the TB button 
in the master section or using one of the 
F-keys if assigned to the TB function.

The Talkback is only sent to the CUE mixes 
as you would not want your talkback to 
also playback through the Main Speakers. 
Therefore, faders will only appear for the 
Talkback channels on the Cue mixes, not on 
the Main Mix.
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Saving & Loading Mixer Presets

To allow you to quickly setup your iD 
Software Mixer during a session you can 
save and load various presets. This is great if 
you are moving between different recording 
scenarios quite often. 

Mixer presets can be saved and loaded in 
two ways:

•	 Using the File menu and selecting either 
Save or Open. 

•	 Using standard keyboard shortcuts :  

Save:	  Mac - 	    Cmd + S
	  Windows - 	    Ctrl + S
Load:	  Mac - 	    Cmd + O
	  Windows - 	    Ctrl + O

Saving a Preset

To save a preset,  simply setup your mixer the 
way that you’d like. Then select File > Save 
as explained above. The iD Software Mixer 
window should then show the ‘Save mixer 
Configuration’ dialog.

Simply enter the name of your preset and 
press the ‘Save’ button.  

It is also possible to export your preset files 
in order to send them to friends or to simply 
save them within your DAW session files for 
easy recall later on. To do this, select Export 
Mixer Configuration at the base of the Save 
screen.

Loading a Mixer Configuration

To load a previously saved preset, select 
File > Open to bring up the ‘Load’ screen.

The previously saved configuration will 
appear in a list.  Select the configuration you 
wish to use and click Load. 

You can also open a mixer configuration 
directly from your computer’s file system 
by selecting ‘Load From File’ located at the 
bottom of the window. 
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Menu/Task Bar Icons

MacOS

On MacOS, the iD icon appears in the menu 
bar in the top right hand corner of the screen. 
This gives you quick access to various functions 
of the iD48. Please note that some functions 
are only visible when the iD48 is connected to 
the Computer.

Show Mixer

Opens the iD Software Mixer Application. 
If the mixer is already open, this option 
will be greyed out. The Mixer cannot be 
opened unless the iD48 is connected to the 
Computer. 

About iD 

Displays information regarding the current 
version of the iD Software Mixer Application. 

Visit iD Knowledge Base

Opens a browser window for the Audient 
Helpdesk with helpful articles and FAQ’s.

Register Product 

Will open the registration screen allowing you 
to register your product to Audient ARC if you 
have not already done so as part of the initial 
setup.

Check for Updates

The iD application will check with the Audient 
update server for any available firmware
updates for iD48. 

Set Clock Source

Allows you to quickly adjust the clock source 
between the internal and optical clocks.

Set Loopback Source

Here you can select which Output Channel 
or Mix will feed the Loopback inputs.

Store Standalone State

It is possible to save your Software Mixer 
setting onto the iD48 itself so that the iD48 
can be used as a standalone device without it 
being connected to a computer via USB. 

To do this, first setup the software mixer as 
desired. Now, go to the Menu bar and click 
‘Setup > Store Standalone State’. The current 
mixer settings will then be stored to the unit. 
The next time the unit is powered down and 
powered up again, it will default to these 
saved settings. 

Please note, its only possible to store one 
Standalone State at one time and storing a 
new state will overwrite the previous one.
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Windows

The Windows taskbar icon has all the same 
options of the MacOS menu bar icon but 
also includes some Windows specific options.

Set Sample Rate

Sets the operating sample rate of iD48. 44.1, 
48, 88.2 and 96kHz are the four options 
available. 

Set ASIO Buffer Size

Sets the buffer size of the iD48 between 16 
and 4096 samples. Higher sizes will take 
processing load off your computer but will 
cause increased latency.

Firmware Update

Occasionally Audient will release a firmware 
update for iD48 in order to address
bugs, improve compatibility and add new 
features. Therefore, you may wish to check 
periodically for any updates.

This can be done by navigating to the Window 
menu and selecting ‘Check for Updates’.

The iD Application will then check with our 
update server if any updates for iD48 are 
available. If there is an update available 
then you will be prompted to install the latest 
version.

Now click ‘Next’ and you’ll be prompted to 
stop any playback through iD48. Click
‘Update’ and the update will begin. iD48 may 
turn off and on a number of times.

Quit

Fully closes the iD application.
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Keyboard Shortcuts

Location		  Mac			  Windows		  Description

Faders		  Alt + Click		  Alt + Click		  Resets fader to unity gain (0 dB)
Pans			   Alt + Click		  Alt + Click		  Resets pan pots to central
									         position	
Solos			   Cmd + Click		  Ctrl + Click		  Clears all solos if clicking on a solo’d
									         channel
									         Overrides all other solos (for solo 	
									         exclusive) if clicking on an unsolo’d 	
									         channel
Meters		  Alt + Click		  Alt + Click		  Clicking on peak hold indicator will 	
									         clear all clip indicators
System Panel	 Cmd + S		  Ctrl + S		  Save mixer configuration
			   Cmd + O		  Ctrl + O		  Load mixer configuration
View Modes		  Cmd + 1		  Ctrl + 1			  View Mic/Line Input
			   Cmd + 2		  Ctrl + 2		  View Optical (Digital) Inputs
			   Cmd + 3		  Ctrl + 3		  View DAW Mix Inputs
			   Cmd + 4		  Ctrl + 4		  View System Panel

Please check the iD48 page online at audient.com/products/iD48
for the latest iD Application updates.

More shortcuts may be added without notification.

Keyboard Shortcut Index

To allow you to find all shortcuts for the mixer 
application in one place without having to 
go through each page of this manual please 
refer to this table:

https://audient.com/products/audio-interfaces/id48/overview/


DAW Setup



I/O Setup

Go to Setup > I/O... to label your inputs and 
outputs and ensure that iD48 is correctly
reporting 24 inputs and 24 outputs to and
from Pro Tools.

For more Pro Tools information consult your 
Avid user manuals & documentation.

Operation with Pro Tools

If using Windows, ensure that you have
followed the installation instructions found on
page 10.

With iD48 connected, launch Pro Tools and
ensure that a new session is created at
the desired sample rate. If you are using
Windows, make sure that you have already
set your Latency and Buffer Size settings in
the iD System Tray before opening a project.
Changing these mid session will result in Pro
Tools needing to restart.

Playback Engine

Go to Setup > Playback Engine... and ensure 
that iD48 is set as the active playback
device. 

Pro Tools Setup
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Operation with Logic Pro

Once iD48 has been successfully installed
following the steps detailed after page 9 of
this manual, launch Logic Pro and check the
following:

Logic Pro > Preferences > Audio

Ensure that iD48 is selected as the active
audio device and set the buffer size (to affect
system latency). If you are experiencing issues
with playback stability and CPU loading, try
increasing the buffer size. This appears with
‘overload’ errors and/or pops and clicks and
distortion in the audio.

Logic Pro Setup
Logic Pro Setup

If you are using the iD Software Mixer 
Application to monitor input signals while 
recording, be sure to disable Logic’s software 
monitoring to avoid phasing as the same 
source will be heard twice with a short delay 
between the low latency DSP signal and the 
delayed software monitoring signal.

Assigning I/O 

All of iD48’s input and output channels will
be available to Logic for routing. There are
a total of 24 inputs and 24 outputs reported
from the driver. You can rename input and
output channels to whatever you wish using
the I/O label function. This is a great way to
keep things organised.

Mix > I/O Labels
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Operation with Logic Pro

If you are using an external clock source
(ADAT or S/PDIF) to clock iD48, please ensure 
that your Logic Pro project is set to the same 
sample rate when recording and playing 
back in a session, otherwise things may sound 
a bit sharp or flat!

File > Project Settings > Audio

If you are using the internal clock in iD48,
setting the sample rate via Logic Pro will 
update the iD48 sample rate to follow your 
session.

There may be a slight pause as the system
re-clocks. This is normal.

This can be verified in Audio MIDI Setup.

Macintosh HD > Applications > Utilities

For more Logic Pro information please 
consult your Apple user manuals & 
documentation.
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Click on Audient iD48 in the side menu. Here 
you will see the main iD48 information, where 
clock sources can be set as well as activating 
I/O ports. Be sure to click Externally Clocked if 
clocking from another digital device via ADAT 
or SPDIF.

I/O ports can be renamed in the device panel 
such that they better represent what you 
connect to them (for example Main Monitors, 
Headphones). This is useful as any names 
chosen here will be those displayed when 
assigning I/O on track input/output channel 
routing.

Operation with Cubase / Nuendo

Once iD48 has been successfully installed 
following the installation process that can 
be found at the start of this manual, launch 
Cubase or Nuendo and head straight for the 
‘Studio’ menu:

Devices > Device Setup...

Select ‘Audio System’ from the list of options.

Select ‘Audient iD48’ in the dropdown menu 
to ensure that Cubase / Nuendo addresses 
the iD48 device driver.

Cubase/Nuendo Setup
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Here you can ensure that all buses have been 
created in Cubase / Nuendo and therefore 
all ports are addressable in your session. Add 
new buses and assign them to the necessary 
I/O if required.

Bus types can be set (mono / stereo) and 
the VST control room section can also be 
used. For more information regarding set-up 
please consult your Steinberg user manuals 
and documentation.

Operation with Cubase / Nuendo

Buffer sizes can be set in the control panel 
within the VST devices display. It is ideal to 
keep them quite high to reduce CPU loading if 
you use the iD Software Mixer Application as 
the input monitoring device while recording.

Close the Studio Setup panel and navigate to 
the Audio connections panel: 

Studio > Audio Connections (F4)

Cubase/Nuendo Setup
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In the Live Audio Preference panel you can 
set an appropriate buffer size (this can be 
kept high if you are monitoring input signals 
for recording via the iD Software Mixer 
Application. Ensure that iD48 reports as a 24 
in, 24 out device to Live. 

If necessary you can limit the number of 
I/O channels reported as active inputs (from 
the driver) in Live by using the input and 
output config tabs. 

This is an excellent feature to help reduce 
CPU loading if all channels are not required.

Operation with Ableton Live

Once iD48 has been successfully installed 
following the installation process that can 
be found at the start of this manual, launch 
Ableton Live and head straight to:

Live > Preferences > Audio

Here navigate to the Audio tab and make sure 
that iD48 is assigned as the playback device.

For more information about setting up audio 
I/O refer to your Ableton Live user manuals & 
documentation. 

Ableton Live Setup
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Troubleshooting

“The unit will not power on”

Double check that the USB cable is plugged
in. If it still won’t power on, try using a different
USB port on the computer and possibly even
a different USB cable. If you are using a USB
hub, please try plugging iD48 directly into the
computer.

“I get clicks and pops on DAW 
playback”

This is most likely to do with setting the
buffer size too low for your computer. This
can be caused by running very large projects
with a lot of plugins and virtual instruments.
Experiment with higher buffer sizes. Typically
you want small buffer sizes for tracking or
recording software synths to keep the latency
low. However when mixing it is fine to set a
slightly higher buffer size as latency is not so
much of a problem.

“When I connect to my computer,
 I cannot play any audio out from iD48”

Firstly double check that the USB cable
connecting iD48 to your computer is
functional and attached at both ends.

Troubleshooting & FAQ
Double check that iD48 is set as the active 
playback device in your DAW and computer:

System Preferences > Sound > Output Tab 
> Audient iD48 (macOS)  
 
Control Panel > Hardware and Sound > 
Sound > Manage Audio Devices > Audient 
iD48  (Windows) 

Launch the iD Software Mixer Application 
to activate communication between your 
computer and iD48. This only needs to be 
done once straight after power up. Once iD48 
is set to the operational state you desire, you 
can quit the iD application and it will continue 
to function as intended.

In the software mixer, locate the DAW
channels by pressing the DAW view button
and increase the level of DAW 1+2 fader.
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Double check that an appropriate clock 
source is selected (Internal for master 
operation), ADAT or S/PDIF clock for 
external slave operation. Ensure that you 
see the correct sample rate displayed in 
the Format drop-down menu.

If you are using Windows, go to the iD 
icon in the system tray and right click on it. 
This will bring up some settings including 
sample rate. Alternatively you can alter 
these settings in the Setup tab of the iD 
app. 

Change the sample rate to match that of 
the external ADAT device and session.

Troubleshooting

“I have clocking issues which include 
iD48 not locking to external ADAT or 
SPDIF devices or operating at the 
incorrect rate compared to my session”

If there is an issue with syncing of an external
device, the Status LED in the System Panel
will be red or yellow. If the status light is red
then iD48 cannot detect a clock signal from an
external device, and yellow if it can detect a
signal at the wrong sample rate.

To change sample rate in macOS, go to Audio 
MIDI Setup found by navigating to the folder:

Macintosh HD > Applications > Utilities > Audio 
MIDI Setup

Ensure that Audient iD48 is seen as an audio 
device (Window Menu > Show Audio Window).
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FAQs

For more information and bug support,
please search our online Help Centre which 
can be found here:

support.audient.com

For technical support please create 
a ticket in our online support system, 
which can also be found in the support section 
of our website (see link above).

Troubleshooting

“How do I reset the iD mixer application 
to its default state?”

To reset the mixer application, quit the 
iD app completely, then navigate to the 
following folder and delete the state.xml file 
(it will replenish upon a fresh launch of the 
application):

Macintosh HD > User > Library > Application 
Support > Audient > iD > state.xml

(C:) > Users > yourusername > AppData > 
Roaming > Audient > iD > state.xml

Do not delete the parent folder as this will 
also contain your iD mixer presets.

“How do I make sure I have the latest   
version of iD firmware/software?”

To check for the latest updates to the
iD desktop mixer application please visit:
audient.com/id48/downloads
download and install the latest driver.

You will be made aware of firmware releases 
from the iD app when connected to the 
internet. Please refer to earlier in this user 
manual for more information regarding 
firmware updates.

https://support.audient.com/hc/en-us
https://support.audient.com/hc/en-us
https://audient.com/products/audio-interfaces/id48/downloads/
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Technical Specifications

Microphone Preamplifier: 

Line Inputs:

Digital Input:

Word Clock Input/Output:

Digital Output:

DSP Mixer Latency
Round Trip (in-to-out)

MIC GAIN:	
LINE GAIN:
PHANTOM POWER:
MIC EIN:
CMRR:
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE (Mic)
INPUT IMPEDANCE (Line)
FREQUENCY RESPONSE:
CROSSTALK: 
THD+N @0dBu (1kHz):
SNR:
XLR:
1/4” JACK:
PAD: 
HPF:

LINE GAIN:	
MAXIMUM INPUT LEVEL: 
THD+N @0dBu 1kHz:

2 x 8-CHANNEL ADAT:
2 x 4-CHANNEL ADAT:
STEREO S/PDIF:

WORD CLOCK: 
WORD CLOCK INPUT TERMINATION: 

2 x 8-CHANNEL ADAT:
2 x 4-CHANNEL ADAT:
STEREO S/PDIF:

44.1kHz
48kHz
88.2kHz
96kHz

0 to +68dB (with 10dB Gain Boost)
-10 to +58dB (with 10dB Gain Boost)
48v +/-4v @ 10mA/Channel
-127dBu
>80dB @ 1kHz
+18dBu
3kΩ balanced
10kΩ balanced
±0.5dB 10Hz to 65kHz
<-115dB @ 1kHz & 10kHz
0.0016% (-96dB)
99dB A-Weighted
Pin 2 (Hot), Pin 3 (Cold) & Pin 1 (Shield) 
TIP (Hot), RING (Cold) & SLEEVE (Shield)
-10dB
-3dB @ 100Hz, 2nd Order (12dB/Octave)

-10 to +48dB
+22dBu
0.0013%, -97dB

44.1kHz to 48kHz
88.2kHz to 96kHz (SMUX)
44.1kHz to 96kHz (Stereo) 

44.1kHz to 96kHz 
75R

44.1kHz to 48kHz
88.2kHz to 96kHz (SMUX)
44.1kHz to 96kHz (Stereo) 

0.344ms
0.312ms
0.188ms
0.177ms

Analogue to Digital Converter:
MAXIMUM INPUT LEVEL:
DIGITAL REFERENCE LEVEL:
INPUT IMPEDANCE:
CROSSTALK:
FREQUENCY RESPONSE:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:
1/4” JACK:

+18dBu (0dBFS digital maximum)
+18dBu = 0dBFS
>10k Ω Balanced
<-118dB @ 1kHz, <-115dB @ 10kHz
±0.5dB 10Hz to Fs/2 (Nyquist) 
<0.0003% (-110dB)
120dB A-weighted
TIP (Hot), RING (Cold) & SLEEVE 
(Shield)

MAXIMUM OUTPUT LEVEL:
OUTPUT IMPEDANCE:
CROSSTALK:
FREQUENCY RESPONSE:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE: 
MAX LEVEL INTO 30R: 
MAX LEVEL INTO 60R: 
MAX LEVEL INTO 600R:
1/4” JACK:

NO. OF INPUT CHANNELS: 
NO. OF OUTPUT CHANNELS:
CONNECTOR: 
INCLUDED CABLES:

*Maximum of 24 unique channels at one time. See page 36 
of this manual for more information.

+18dBu (0dBFS digital maximum)
<50 Ω unbalanced
<-117dB @ 1kHz, -112 @ 10kHz
±0.5dB 10Hz to Fs/2
<0.00023% (-112dB)
121dB un-weighted, 124dB A-weighted
4V Peak, 2.85V RMS, 530mW
5.82V Peak, 4.12V RMS, 565mW
8.71V Peak, 6.16V RMS, 126mW
TIP (Hot), RING (Cold) & SLEEVE (Shield)

24 (8 Analogue, 16 Digital)
32 (16 Analogue, 16 Digital)* 
USB Type-C 
1m USB 2.0 Type-C to Type-C

Headphone Outputs:

USB 2.0 High Speed:

D.I GAIN:
MAXIMUM INPUT LEVEL:
INPUT IMPEDANCE: 
FREQUENCY RESPONSE:
THD+N @ 0dBu (1kHz):
SNR:
1/4” JACK:

0 to +68dB (with 10dB Gain Boost)
+15dBu 
500kΩ unbalanced
±0.5dB 10Hz to 40kHz
<0.06%
96dB A-weighted
TIP (Hot), RING (Cold) & SLEEVE 
(Shield)

D.I / Instrument Input:

Digital to Analogue Converter 
MAXIMUM OUTPUT LEVEL:
OUTPUT IMPEDANCE:
CROSSTALK:
FREQUENCY RESPONSE:
THD+N @ -1dBFS (1kHz):
DYNAMIC RANGE:
1/4” TRS JACK: 

+18dBu (0dBFS digital maximum)
<100 Ω
<-120dB @ 1kHz, <-115 @ 10kHz
±0.5dB 10Hz to Fs/2 (Nyquist)
<0.00026% (-111.5dB)
124dB un-weighted, 126.5dB A-weighted
TIP (Hot), RING (Cold) & SLEEVE (Shield) 



60

437mm

50m
m

327m
m

Dimensions



Warranty Statement

Your iD48 comes with a manufacturer’s warranty for three years (36 months) from the
date of despatch to the end user.

The warranty covers faults due to defective materials used in manufacture and faulty
workmanship only.

During the warranty period Audient will repair at its discretion or replace the faulty unit
provided it is returned carriage paid to an authorised Audient service centre. We will not
provide warranty repair if in our opinion the fault has resulted from unauthorised modification, 
misuse, negligence or accident.

We accept liability to repair or replace your iD48 as described above. We do not accept
any additional liability. This warranty does not affect any legal rights you may have against
the person who supplied this product - it is additional to those rights.

Warranty Limitations

This warranty does not cover damage resulting from accident or misuse. The warranty is void 
unless repairs are carried out by an authorised service centre. The warranty is void if the unit 
has been modified other than at the manufacturer’s instruction. The warranty does not cover 
components which have a limited life, and which are expected to be periodically replaced for 
optimal performance. We do not warrant that the unit shall operate in any other way than as 
described in this manual.

For the full ‘Terms and Conditions’ please head over https://audient.com/warranty/

Warranty
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https://audient.com/warranty/


Audient Ltd
Aspect House
Herriard
Hampshire
RG25 2PN
United Kingdom

Tel: +44 (0) 1256 381944
audient.com

62

Service Information

iD48 contains no user-serviceable components, please refer to qualified service personnel
for diagnosis and repair. Your warranty will be void if you tamper with the device at the component 
level. If you have any questions with regard to the repair, please contact Audient Ltd.

If your unit is in warranty, please contact your dealer directly for a repair or replacement (at the 
discretion of the dealer).

For out of warranty repairs, please contact Audient Ltd, after which a Return Materials 
Authorization (RMA) number will be assigned. This number will serve as a reference for you 
and helps facilitate and expedite the return process. When the unit is returned please include this 
RMA number along with a description of the fault inside the packaging box.

To request an RMA, access technical support & FAQs, ask for troubleshooting assistance or make 
an enquiry, please visit: support.audient.com

Service

https://audient.com/
https://support.audient.com/hc/en-us
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A		  Amperes
ADAT		  Alesis Digital Audio Tape
ADC		  Analogue to Digital Converter
DAW		  Digital Audio Workstation
ASP		  Analogue Signal Processing
CPU		  Central Processing Unit
CUE		  Artist Headphone Mix
DAC		  Digital to Analogue Converter
dB		  Decibel
dBu		  Decibel referenced to 0.775Vrms = 0 dBu
dBFS		  Decibel Full Scale
DC		  Direct Current
D.I		  Direct Injection (Instrument Input)
DoC		  Declaration of Conformity
DSP		  Digital Signal Processing
EQ		  Equaliser
FAQ		  Frequently Asked Questions
FCC		  Federal Communications Commission
GB		  Gigabyte
GUI		  Graphical User Interface
HPF		  High Pass Filter
HV		  High Voltage
i/o		  Input / Output
JFET		  Junction Field Effect Transistor
LED		  Light Emitting Diode
RoHS		  Restriction of Hazardous Substances
RAM		  Random Access Memory
S/PDIF	 Sony Philips Digital Interface Format
THD+N	 Total Harmonic Distortion + Noise
TRS		  Tip Ring Sleeve (1/4” Jack Balanced)
TS		  Tip Sleeve (1/4” Jack Unbalanced)
USB		  Universal Serial Bus
V		  Volts
XLR		  Extra Live Return, Extremely Low Resistance, Canon X Series, Latching,
		  Resilient Rubber Compound... or make up your own!

Glossary
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